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Introduction
MPLAB® Harmony v3 is a software development framework consisting of compatible and interoperable
modules that include peripheral libraries (PLIBs), drivers, system services, middleware, and third-party libraries.
The MPLAB Code Configurator (MCC) is a GUI-based tool that provides an easy way to enable and configure
various MPLAB Harmony modules. The MCC is a plug-in to the MPLAB X Integrated Development Environment
(IDE).

This document describes how to create a simple application on a Arm® Cortex-M4F based PIC32CX SG
Microcontroller using the MCC with MPLAB Harmony v3 modules. The objective of this Application is to toggle
an LED on a timeout basis and print the LED toggling rate and temperature reading periodically on a serial
console. For this demonstration, the following MPLAB Harmony v3 modules are used and configured using the
MCC:

• The PORT pin to toggle the LED.
• Real-Time Clock (RTC) PLIB to periodically sample the LED toggling rate and temperature reading.
• Two instances of the External Interrupt Controller (EIC) PLIB: one to change the toggling rate when there is a

switch press event and another one to decide what needs to be printed on the Serial Console; temperature
reading or LED toggling rate.

• SERCOM (configured as I2C) PLIB to read the temperature from an on-board temperature sensor.
• SERCOM (configured as USART) and DMA PLIBs to print the LED toggling rate and temperature reading on a

COM (serial console) port terminal application running on a PC.
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1. Creating First Application on the PIC32CX SG61 MCU
The following software and hardware tools are used for this demonstration:

• MPLAB X IDE v6.15
• MPLAB Code Configurator (MCC) Plug-in v5.3.7
• MPLAB XC32 Compiler v4.30
• MPLAB Harmony v3 repositories:

– csp v3.18.0
– dev_packs v3.18.0

• PIC32CX SG61 Curiosity Ultra Evaluation Board

Note: The updated versions of the above listed tools can also be used to create the application, and
users are not restricted to the usage of the older versions.

To create an MPLAB Harmony v3-based project, follow these steps:

1. From the Start Menu launch MPLAB X IDE.
2. Once MPLAB X IDE is open, on the File Menu click New Project or click on the new project icon.
3. In the New Project window, under Steps navigation pane, select Choose Project.
4. In the right Choose Project properties page, under Categories select Microchip Embedded, and

under Projects select 32-bit MCC Harmony Project.

Figure 1-1. Choose Project

5. Click Next.
6. In the left navigation pane, select Framework Selection and in the right Manage Framework

properites page, enter these details:
a. Harmony Repository: Enter the path https://github.com/Microchip-MPLAB-Harmony.
b. Framework Path: Enter C:\h3 (path to the folder in which the MPLAB Harmony v3 packages

are downloaded).

https://www.microchip.com/mplab/mplab-x-ide
https://www.microchip.com/en-us/tools-resources/configure/mplab-code-configurator
https://www.microchip.com/mplab/compilers
https://github.com/Microchip-MPLAB-Harmony/csp
https://github.com/Microchip-MPLAB-Harmony/dev_packs
https://www.microchip.com/en-us/development-tool/EV09H35A
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Figure 1-2. Framework Selection

Note: For this demonstration application, the following MPLAB Harmony v3 packages are
required: dev_packs and csp. The MCC Content Manager simplifies the downloading of the
MPLAB Harmony v3 packages. If these packages are not downloaded, refer to the MPLAB® Code
Configurator Content Manager for MPLAB Harmony v3 Projects video to download it.

7. Click Next.
8. In the left navigation pane, select Project Settings and in the Name and Locations properties

page, enter these details:
Location: Enter C:\microchip\h3\tech_brief (Indicates the path to the root folder of the new
project. All project files will be placed in this folder. The project location can be any valid path).
Folder: Enter pic32cx_sg61_cult (Indicates the name of the MPLAB X IDE .X folder to create a
pic32cx_sg61_cult.X folder).
Name: Enter getting_started_pic32cx_sg61_cult (Indicates the name of the project that
will be shown in MPLAB X IDE to set the project's name).
Path: Read-only content (Automatically updates when users make changes to the above entries).
Note: This project can also be created for the PIC32CX SG41 Curiosity Ultra Evaluation Board by
following the similar steps to create and configure the project.

Figure 1-3. Project Settings

Note: Click on the Show Visual Help button to open a contextual help window for a detailed
description of the various fields in the Project Settings.

https://www.youtube.com/watch?v=PRewTzrI3iE
https://www.youtube.com/watch?v=PRewTzrI3iE
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9. Click Next.
10. In the left navigation pane, select Configuration Settings and in the right Configuration Settings

properties page, enter these details:
– Name: Enter pic32cx_sg61_cult.

– Device Family: All.
– Device Filter: Enter PIC32CX1025SG.
– Target Device: In the drop-down item list select PIC32CX1025SG61128 for creating the

project on the PIC32CX SG61 Curiosity Ultra Evaluation Board (The Device Filter entry will be
reflected under the Target Device).

Figure 1-4. Configuration Settings

Note: Click on the Show Visual Help button to open a contextual help window for a detailed
description of various fields in the Configuration Settings.

11. Click Finish to launch the MCC.
12. Before launching the MCC, the Configuration Database Setup window will be displayed, where

the Device Family Pack (DFP) and Cortex® Microcontroller Software Interface Standard (CMSIS)
path can be changed if required. For this demonstration, the default settings are used.

13. The MCC plug-in will open in a new window as shown in the following figure:
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Figure 1-5. MPLAB Code Configurator Window

1.1 Adding and Configuring MPLAB Harmony Components
To add and configure the MPLAB Harmony components using the MCC, follow these steps:

1. In the MCC window, from the Plugins drop-down list, select the required Configuration Window.

Figure 1-6. MPLAB Code Configurator - Plugins

2. Select Clock Configuration in the drop-down list to open the Clock Easy View window, and verify
that the Main Clock is set to 120 MHz.
Note: Make sure to make the following modification for GCLK Generator 1.



 TB3345
Creating First Application on the PIC32CX SG61 MCU

 Technical Brief
© 2023 Microchip Technology Inc. and its subsidiaries

DS90003345A - 6

Figure 1-7. MPLAB Code Configurator - GCLK Generator 1

3. Under Device Resources, select Peripherals > SERCOM > SERCOM6 and observe that the SERCOM6
Peripheral Library block is added in the Project Graph Window.
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Figure 1-8. MPLAB Code Configurator - Selection of Peripherals

Note: Similarly all peripherals can be selected under Device Resources > Peripherals.
4. In the left pane, select the SERCOM6 Peripheral Library in the Project Graph. In the Configuration

Options right pane, configure it as follows to read the temperature from the on-board
temperature sensor of the evaluation board.
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Figure 1-9. MPLAB Code Configurator - SERCOM6 Configuration

Note: The SCL clock is not configured for 100 kHz, tune the GCLK to achieve 100 kHz.
5. Under Device Resources, select Peripherals > SERCOM > SERCOM4 and observe that the SERCOM4

Peripheral Library block is added in the Project Graph Window.
6. In the left pane Project Graph, select SERCOM4 Peripheral Library and right-click on the UART,

and then under consumers select STDIO. This establishes a connection between the STDIO and
SERCOM4 as a UART. In the Configuration Options right pane, configure it as shown in the figure
below to print the data on a Serial Console at 115200 baud rate. Clear the Receive Enable check
box or change the Receive Pinout to PAD1.
Note: PAD0 is configured for TX and RX.

Figure 1-10. MPLAB Code Configurator - SERCOM4 Configuration

7. From the Plugins drop-down list select DMA Configuration, and configure DMA Channel 0 to
transmit the application buffer to the USART TX register. The DMA transfers one byte from the
user buffer to the USART transmit buffer on each trigger.
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Figure 1-11. MPLAB Code Configurator - DMA Configuration

Note: Both the SERCOM4 as USART and the DMA Peripheral Libraries obtain the LED toggling
rate and temperature reading from the application and print the data on a serial console running
on a PC.

8. Under Device Resources, select Peripherals > RTC > RTC and observe that the RTC Peripheral
Library block is added in the Project Graph Window to generate a compare interrupt every 500
milliseconds.

Figure 1-12. MPLAB Code Configurator - RTC PLIB Configuration

Note: The Compare Value is set as 0x200. This compare value generates an RTC compare
interrupt every 500 milliseconds.
RTC clock = 1024 Hz
RTC Prescaler = 1
Required Interrupt rate = 500 ms
Therefore, Compare Value = (500/1000) x 1024 = 512 (i.e., 0x200).

9. Under Device Resources, select Peripherals > EIC > EIC and observe that the EIC Peripheral Library
block is added in the Project Graph Window, and enable interrupts for switch press events.
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Figure 1-13. MPLAB Code Configurator - EIC PLIB Configuration

10. Open the Pin Configuration Window from the Plugins drop-down list and configure required pins
as follows:

Figure 1-14. Pin Settings Window - EIC Pin Configuration

Figure 1-15. Pin Settings Window - SERCOM Pin Configuration

Figure 1-16. Pin Settings Window - LED Pin Configuration

1.2 Generating Code
After configuring the peripherals, click Resource Management [MCC] and then click on the
Generate tab.
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Figure 1-17. Generation of Code

Note: The generated code will add files and folders to the 32-bit MCC Harmony v3 project. In the
generated code, notice the Peripheral Library files generated for Real-Time Clock (RTC), External
Interrupt Controller (EIC), PORT peripherals, SERCOM4 (as Universal Synchronous Asynchronous
Receiver Transmitter (USART)), Direct Memory Access (DMA) peripherals, and SERCOM6 (as I2C PLIB).
The MCC also generates the main.c file.

Note: The MCC provides an option to change the generated file name, and if this option is not used,
by default, the file name main.c is generated.

1.3 Adding Application Logic to the Project
To develop and run the application, follow these steps:

1. Open the main.c file of the project and add the following application logic:
//Declare and Define the array inside main() function:
uint8_t uartLocalTxBuffer[100] = {0};
//Register the callback event handlers:
SERCOM6_I2C_CallbackRegister(i2cEventHandler, 0);
MCP9804TempSensorInit();
DMAC_ChannelCallbackRegister(DMAC_CHANNEL_0,usartDmaChannelHandler, 0);
EIC_CallbackRegister(EIC_PIN_0, EIC_SW1_User_Handler, 0);
EIC_CallbackRegister(EIC_PIN_1, EIC_SW2_User_Handler, 0);
RTC_Timer32CallbackRegister(rtcEventHandler, 0);

sprintf((char*)uartTxBuffer, "Toggling LED at 500 milliseconds rate \r\n");
//Start the Timer:
    RTC_Timer32Start();

Figure 1-18. Adding Application Logic to Register Callback Event Handlers

2. Implement the registered callback event handlers for peripherals by adding the following code:
static void EIC_SW1_User_Handler(uintptr_t context)
{
    if(SW1_Get() == SWITCH_PRESSED_STATE)
    {
        changeTempSamplingRate = true;
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    }
}

static void EIC_SW2_User_Handler(uintptr_t context)
{
    if(SW2_Get() == SWITCH_PRESSED_STATE)
    {
        if(false == startTemperatureReading)
        {
            startTemperatureReading = true;
            sprintf((char*)uartTxBuffer, "************* Printing Temperature 
*************\r\n");
            TemperatureReadStartMsgLen = strlen((const char*)uartTxBuffer);
        }
        else
        {
            startTemperatureReading = false;
            sprintf((char*)uartTxBuffer, "************* Printing Toggling LED rate 
*************\r\n");
            TemperatureReadStartMsgLen = strlen((const char*)uartTxBuffer);
        }
    }
}

static void rtcEventHandler (RTC_TIMER32_INT_MASK intCause, uintptr_t context)
{
    if (intCause & RTC_MODE0_INTENSET_CMP0_Msk)
    {
        isRTCExpired    = true;
    }
}

static void usartDmaChannelHandler(DMAC_TRANSFER_EVENT event, uintptr_t contextHandle)
{
    if (event == DMAC_TRANSFER_EVENT_COMPLETE)
    {
        isUARTTxComplete = true;
    }
}

static void i2cEventHandler(uintptr_t contextHandle)
{
    if (SERCOM6_I2C_ErrorGet() == SERCOM_I2C_ERROR_NONE)
    {
        isTemperatureRead = true;
    }
}

3. According to the status of the isRTCExpired and isUARTTxComplete flags, the LED1 is toggled
at a default rate of 500 ms. These flags are handled by the rtcEventHandler and the
usartDmaChannelHandler when the RTC Timer expires, and when the UART completes the
transfer of data. To change the toggling rate, if the user presses the SW1 switch, the toggling
rate changes to 1 second, 2 second, 4 second, and back to 500 millisecond with subsequent
switch press events. The EIC_SW1_User_Handler will be responsible for changing the toggling rate
when the user presses the SW1 switch on the board.
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Figure 1-19. Application Logic to Print LED Toggling Rate

Inside the while loop, add the following code to toggle the LED at a default rate of 500 ms:
while(false == startTemperatureReading)
        {
            if ((isRTCExpired == true) && (true == isUARTTxComplete))
            {
                isRTCExpired = false;
                isUARTTxComplete = false;
                LED1_Toggle();
                sprintf((char*)(uartTxBuffer + 
TemperatureReadStartMsgLen), "Toggling LED at %s rate \r\n", 
&timeouts[(uint8_t)tempSampleRate][0]);
                TemperatureReadStartMsgLen = 0;
                DMAC_ChannelTransfer(DMAC_CHANNEL_0, uartTxBuffer, \
                    (const void *)&(SERCOM4_REGS->USART_INT.SERCOM_DATA), \
                    strlen((const char*)uartTxBuffer));
            }

Add the following code immediately after adding the above code to change the toggling rate
when there is a switch press event:
if(changeTempSamplingRate == true)
            {
                changeTempSamplingRate = false;
                if(tempSampleRate == TEMP_SAMPLING_RATE_500MS)
                {
                    tempSampleRate = TEMP_SAMPLING_RATE_1S;
                    RTC_Timer32Compare0Set(PERIOD_1S);
                }
                else if(tempSampleRate == TEMP_SAMPLING_RATE_1S)
                {
                    tempSampleRate = TEMP_SAMPLING_RATE_2S;
                    RTC_Timer32Compare0Set(PERIOD_2S);
                }
                else if(tempSampleRate == TEMP_SAMPLING_RATE_2S)
                {
                    tempSampleRate = TEMP_SAMPLING_RATE_4S;
                    RTC_Timer32Compare0Set(PERIOD_4S);
                }
                else if(tempSampleRate == TEMP_SAMPLING_RATE_4S)
                {
                   tempSampleRate = TEMP_SAMPLING_RATE_500MS;
                   RTC_Timer32Compare0Set(PERIOD_500MS);
                }
                else
                {
                    ;
                }
                RTC_Timer32CounterSet(0);
                sprintf((char*)uartLocalTxBuffer, "LED Toggling rate is changed to 
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%s\r\n", &timeouts[(uint8_t)tempSampleRate][0]);
                DMAC_ChannelTransfer(DMAC_CHANNEL_0, uartLocalTxBuffer, \
                    (const void *)&(SERCOM4_REGS->USART_INT.SERCOM_DATA), \
                    strlen((const char*)uartLocalTxBuffer));
            }
        }

4. Inside the while loop if the startTemperatureReading flag status is true, then temperature reading
is printed on the serial console, otherwise the LED toggling rate will be printed. The status of this
flag is controlled by the EIC_SW2_User_Handler when there is a SW2 switch press event. Add the
logic to read and print the temperature reading from the temperature sensor:
if (isRTCExpired == true)
        {
            isRTCExpired = false;
            SERCOM6_I2C_WriteRead(TEMP_SENSOR_SLAVE_ADDR, &i2cWrData, 1, i2cRdData, 2);
        }

        if (isTemperatureRead == true)
        {
            isTemperatureRead = false;
            if(changeTempSamplingRate == false)
            {
                temperatureVal = getTemperature(i2cRdData);
                sprintf((char*)(uartTxBuffer + TemperatureReadStartMsgLen), "Temperature = 
%02d F\r\n", (int)temperatureVal);
                TemperatureReadStartMsgLen = 0;
                LED1_Toggle();
            }
            else
            {
                changeTempSamplingRate = false;
                RTC_Timer32CounterSet(0);
                if(tempSampleRate == TEMP_SAMPLING_RATE_500MS)
                {
                    tempSampleRate = TEMP_SAMPLING_RATE_1S;
                    sprintf((char*)uartTxBuffer, "Sampling Temperature every 1 second 
\r\n");
                    RTC_Timer32Compare0Set(PERIOD_1S);
                }
                else if(tempSampleRate == TEMP_SAMPLING_RATE_1S)
                {
                    tempSampleRate = TEMP_SAMPLING_RATE_2S;
                    sprintf((char*)uartTxBuffer, "Sampling Temperature every 2 seconds 
\r\n");
                    RTC_Timer32Compare0Set(PERIOD_2S);
                }
                else if(tempSampleRate == TEMP_SAMPLING_RATE_2S)
                {
                    tempSampleRate = TEMP_SAMPLING_RATE_4S;
                    sprintf((char*)uartTxBuffer, "Sampling Temperature every 4 seconds 
\r\n");
                    RTC_Timer32Compare0Set(PERIOD_4S);
                }
                else if(tempSampleRate == TEMP_SAMPLING_RATE_4S)
                {
                   tempSampleRate = TEMP_SAMPLING_RATE_500MS;
                   sprintf((char*)uartTxBuffer, "Sampling Temperature every 500 ms \r\n");
                   RTC_Timer32Compare0Set(PERIOD_500MS);
                }
                else
                {
                    ;
                }
                RTC_Timer32Start();
            }
            DMAC_ChannelTransfer(DMAC_CHANNEL_0, uartTxBuffer, \
                (const void *)&(SERCOM4_REGS->USART_INT.SERCOM_DATA), \
                strlen((const char*)uartTxBuffer));
        }
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Figure 1-20. Application Logic to Print Temperature Reading

5. Add the following code to include the necessary header files, and define the macros for different
RTC compare values:
#include <stdio.h>
#include <stddef.h>                     // Defines NULL
#include <stdbool.h>                    // Defines true
#include <stdlib.h>                     // Defines EXIT_FAILURE
#include <string.h>
#include "definitions.h"                // SYS function prototypes

#define TEMP_SENSOR_SLAVE_ADDR          0x18
#define TEMP_SENSOR_REG_ADDR            0x05

#define SWITCH_PRESSED_STATE            1   // Active HIGH switch

/* RTC Time period match values for input clock of 1 KHz */
#define PERIOD_500MS                    512
#define PERIOD_1S                       1024
#define PERIOD_2S                       2048
#define PERIOD_4S                       4096

This code declares various flags whose status is monitored and changed by event handlers in the
application. It has various declarations and definitions of arrays used to read the data from the
temperature sensor and print to the console.
typedef enum
{
    TEMP_SAMPLING_RATE_500MS = 0,
    TEMP_SAMPLING_RATE_1S = 1,
    TEMP_SAMPLING_RATE_2S = 2,
    TEMP_SAMPLING_RATE_4S = 3,
} TEMP_SAMPLING_RATE;

static TEMP_SAMPLING_RATE tempSampleRate = TEMP_SAMPLING_RATE_500MS;
static volatile bool changeTempSamplingRate = false;
static volatile bool startTemperatureReading = false;
static volatile uint8_t TemperatureReadStartMsgLen = 0x00;
static volatile bool isTemperatureRead = false;
static volatile bool isRTCExpired = false;
static volatile bool isUARTTxComplete = true;
static uint8_t temperatureVal = 0;
static uint8_t i2cWrData = TEMP_SENSOR_REG_ADDR;
static uint8_t i2cRdData[2] = {0};
static const char timeouts[4][20] = {"500 milliSeconds", "1 Second",  "2 Seconds",  "4 
Seconds"};
static uint8_t uartTxBuffer[100] = {0};
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6. Add the functions to initialize the temperature sensor and the function to convert the
temperature reading to degrees Fahrenheit.
static void MCP9804TempSensorInit(void)
{
    uint8_t config[3] = {0};
    config[0] = 0x01;
    config[1] = 0x00;
    config[2] = 0x00;

    SERCOM6_I2C_Write(TEMP_SENSOR_SLAVE_ADDR, config, 3);

    while (isTemperatureRead != true);
    isTemperatureRead = false;

    config[0] = 0x08;
    config[1] = 0x03;
    SERCOM6_I2C_Write(TEMP_SENSOR_SLAVE_ADDR, config, 2);

    while (isTemperatureRead != true);
    isTemperatureRead = false;
}

static uint8_t getTemperature(uint8_t* rawTempValue)
{

    int temp = ((rawTempValue[0] & 0x1F) * 256 + rawTempValue[1]);
    if(temp > 4095)
    {
        temp -= 8192;
    }
    float cTemp = temp * 0.0625;
    float fTemp = cTemp * 1.8 + 32;
    return (uint8_t)fTemp;
}

1.4 Building and Programming the Application
1. The PIC32CX SG61 Curiosity Ultra Evaluation Board supports debugging using an Embedded

Debugger (EDBG). Connect the "Type-A male to micro-B" USB cable to the micro-B debug USB
port on the PIC32CX SG61 Curiosity Ultra Evaluation Board to power and debug the PIC32CX
SG61 Curiosity Ultra Evaluation Board.
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Figure 1-21. Hardware Setup
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2. Set getting_started_pic32cx_sg61_cult as the main project, and from Project Properties
select the latest compiler version (v4.30).

3. To clean and build the project, click  (the Build icon).

4. To program the application, click  (the Program icon).

1.5 Observing the Output on the Board and Serial Terminal
1. After building the application and completing the programming, open the Tera Term tool on the

PC.
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Figure 1-22. Selection of Serial Port

2. Select the Serial Port and set the baud rate as 115200.
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Figure 1-23. Setting the Baud Rate

3. Press the Reset button on the PIC32CX SG61 Curiosity Ultra Evaluation Board. The LED will toggle
at 500 millisecond by default and with every subsequent SW1 switch press, the LED toggling rate
will change to 1 second, 2 second, and 4 second.

4. Press the SW2 switch on the PIC32CX SG61 Curiosity Ultra Evaluation Board to read and print the
temperature on the Serial Terminal application running on the PC.

5. Press the SW1 switch on the PIC32CX SG61 Curiosity Ultra Evaluation Board to change the
periodicity of the temperature values displayed on the serial console.
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Figure 1-24. LED Toggling Rate and Temperature Reading on Serial Terminal

The LED toggling rate on the Serial Terminal changes with every subsequent switch press. The
same change is observed in the toggling rate of LED1 on the evaluation board.
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2. Resources
• For additional information on MPLAB Harmony v3, refer to the Microchip web site:

https://www.microchip.com/mplab/mplab-harmony and microchipdeveloper.com/
harmony3:start

• For more information on various applications, refer to:
github.com/Microchip-MPLAB-Harmony/reference_apps

• For the example application, refer “Getting Started Application with PIC32CX SG61 Curiosity Ultra
Evaluation Board” under the “Software” heading:
www.microchip.com/en-us/development-tool/ev09h35a

• PIC32CX SG61 Curiosity Ultra Evaluation Board

https://www.microchip.com/en-us/tools-resources/configure/mplab-harmony
https://microchipdeveloper.com/harmony3:start
https://microchipdeveloper.com/harmony3:start
https://github.com/Microchip-MPLAB-Harmony/reference_apps
https://www.microchip.com/en-us/development-tool/ev09h35a
https://www.microchip.com/en-us/development-tool/EV09H35A
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3. Revision History
Revision A - November 2023
This is the initial release of this document.
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Microchip Information
The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to
make files and information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests,
online discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip
products. Subscribers will receive email notification whenever there are changes, updates, revisions
or errata related to a specified product family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are
also available to help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within

operating specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the

code protection features of Microchip product is strictly prohibited and may violate the Digital
Millennium Copyright Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its
code. Code protection does not mean that we are guaranteeing the product is “unbreakable”.
Code protection is constantly evolving. Microchip is committed to continuously improving the
code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including
to design, test, and integrate Microchip products with your application. Use of this information
in any other manner violates these terms. Information regarding device applications is provided
only for your convenience and may be superseded by updates. It is your responsibility to ensure

https://www.microchip.com/
https://www.microchip.com/pcn
https://www.microchip.com/support
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that your application meets with your specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at www.microchip.com/en-us/support/design-help/
client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR
ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO
MICROCHIP FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk,
and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise,
under any Microchip intellectual property rights unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, Adaptec, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer,
LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST,
MOST logo, MPLAB, OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer,
QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer,
Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.

AgileSwitch, ClockWorks, The Embedded Control Solutions Company, EtherSynch, Flashtec, Hyper
Speed Control, HyperLight Load, Libero, motorBench, mTouch, Powermite 3, Precision Edge,
ProASIC, ProASIC Plus, ProASIC Plus logo, Quiet-Wire, SmartFusion, SyncWorld, TimeCesium,
TimeHub, TimePictra, TimeProvider, and ZL are registered trademarks of Microchip Technology
Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut,
Augmented Switching, BlueSky, BodyCom, Clockstudio, CodeGuard, CryptoAuthentication,
CryptoAutomotive, CryptoCompanion, CryptoController, dsPICDEM, dsPICDEM.net, Dynamic
Average Matching, DAM, ECAN, Espresso T1S, EtherGREEN, EyeOpen, GridTime, IdealBridge,
IGaT, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, IntelliMOS, Inter-Chip
Connectivity, JitterBlocker, Knob-on-Display, MarginLink, maxCrypto, maxView, memBrain, Mindi,
MiWi, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, mSiC, MultiTRAK, NetDetach, Omniscient
Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, Power MOS IV, Power MOS 7, PowerSmart,
PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-ICE, Serial Quad I/O, simpleMAP,
SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher, SuperSwitcher II,
Switchtec, SynchroPHY, Total Endurance, Trusted Time, TSHARC, Turing, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip
Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered
trademarks of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary
of Microchip Technology Inc., in other countries.

https://www.microchip.com/en-us/support/design-help/client-support-services
https://www.microchip.com/en-us/support/design-help/client-support-services


 TB3345

 Technical Brief
© 2023 Microchip Technology Inc. and its subsidiaries

DS90003345A - 25

All other trademarks mentioned herein are property of their respective companies.
© 2023, Microchip Technology Incorporated and its subsidiaries. All Rights Reserved.
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Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit
www.microchip.com/quality.

https://www.microchip.com/quality
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Tel: 886-3-577-8366
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Tel: 886-7-213-7830

Taiwan - Taipei
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